<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Getting Started</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>DataMan 8000 Software</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>Connection Options</td>
<td>18</td>
</tr>
<tr>
<td>4</td>
<td>Using DataMan 8100/8500 Wireless Readers</td>
<td>28</td>
</tr>
<tr>
<td>5</td>
<td>Reading Codes with the DataMan 8100/8500</td>
<td>46</td>
</tr>
<tr>
<td>6</td>
<td>Industrial Protocols, Compliance Information, Warnings and Notices</td>
<td>50</td>
</tr>
</tbody>
</table>
About DataMan 8100 and 8500

The DataMan 8100 and 8500 readers offer the industry’s most advanced technology for reading 1D and 2D codes regardless of size, quality, printing method or surface, and belong to the only industrial handheld ID reader family that offers Industrial Ethernet communication.

The DataMan 8100 and 8500 readers are available with patented 1DMax+ with Hotbars, class-leading 2-D algorithms and future-proof modular communication slide-ins.

The DataMan 8500 readers use Cognex’s patented UltraLight® technology for superior image formation on any mark type and surface. UltraLight illumination provides dark field, bright field and diffuse lighting all in one electronically controlled light. The DataMan 8500 readers include liquid lens technology and Cognex’s 2DMax+ algorithms for the most challenging barcodes of all types.

The DataMan 8100 readers feature integrated bright field illumination ideal for applications that require superior reading performance with direct lighting. DataMan 8100 readers include liquid lens technology and Cognex’s 2DMax+ algorithms.

The DataMan 8100 and 8500 readers are available with the following communication options:

<table>
<thead>
<tr>
<th></th>
<th>Ethernet</th>
<th>USB</th>
<th>RS-232</th>
<th>WiFi</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataMan 8100</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DataMan 8500</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

An intelligent base station is also provided when the DataMan 8100 and 8500 readers use the wireless (WiFi) communication module. The base station acts as a router between the reader and your computer or network. Infrastructure Mode does not use the base station for communication (see page 34-35).

The DataMan 8100 and 8500 base stations are available with the following communication options:

<table>
<thead>
<tr>
<th>Base Station Communication</th>
<th>Wireless Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ethernet with Industrial Protocols</td>
</tr>
<tr>
<td>DMA-IBASE-00</td>
<td>✓</td>
</tr>
<tr>
<td>DMA-CBASE-00</td>
<td>✓</td>
</tr>
</tbody>
</table>
### DataMan 8100/8500 Accessories

<table>
<thead>
<tr>
<th>Accessory Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial/USB slide-in</td>
<td>DMCM-SERIALM-00</td>
</tr>
<tr>
<td>Ethernet slide-in</td>
<td>DMCM-ENETM-00</td>
</tr>
<tr>
<td>Wireless slide-in</td>
<td>DMCM-WLESSM-00</td>
</tr>
<tr>
<td>Intelligent Base Station</td>
<td>DMA-IBASE-00</td>
</tr>
<tr>
<td>Charging Base Station</td>
<td>DMA-CBASE-00</td>
</tr>
<tr>
<td>Power Supply for base station</td>
<td>DMA-24VPWR-xx</td>
</tr>
<tr>
<td>Power Supply for reader</td>
<td>DM100-PWR-00</td>
</tr>
<tr>
<td>POE Adapter</td>
<td>CPS-AC-POE1A-xx</td>
</tr>
<tr>
<td>POE Adapter</td>
<td>CPS-24V-POE1</td>
</tr>
<tr>
<td>POE Adapter</td>
<td>CPS-24V-POE4</td>
</tr>
<tr>
<td>Wall Mount</td>
<td>DMA-WALL-8000-00</td>
</tr>
<tr>
<td>Wall Mount for Base Station</td>
<td>DMA-IBASE-WALL-00</td>
</tr>
<tr>
<td>Battery for the wireless reader</td>
<td>DMA-HHBATTERY-00</td>
</tr>
<tr>
<td>Battery for the wireless reader</td>
<td>DMA-HHBATTERY-01</td>
</tr>
</tbody>
</table>

### DataMan 8100 and 8500 Reader Cables

<table>
<thead>
<tr>
<th>Cable Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 coiled cable for reader</td>
<td>DM8000-RS232-02</td>
</tr>
<tr>
<td>USB coiled cable, 2.5 m</td>
<td>DM8500-USBC-02</td>
</tr>
<tr>
<td>USB coiled cable, 2.5 m</td>
<td>DM8500-USB-00</td>
</tr>
<tr>
<td>Multi-Battery Charger</td>
<td>DMA-MBC-xx</td>
</tr>
<tr>
<td>PS/2 adapter cable</td>
<td>DM700-PS2-00</td>
</tr>
<tr>
<td>RS-232 coiled cable for reader, 5 m</td>
<td>DM8000-RS232-05</td>
</tr>
<tr>
<td>RS-232 industrial cable for reader</td>
<td>DM8000-RS232IND-02</td>
</tr>
<tr>
<td>USB cable, 2.5 m</td>
<td>DM8500-USB-00</td>
</tr>
</tbody>
</table>
DataMan 8100/8500 Accessories (Continued)

- Ethernet cable, 5 m
  DM8000-ECABLE-05
- Ethernet cable, 30 m
  DM8000-ECABLE-30
- Ethernet cable, 2.5 m
  DM8000-ECABLE-02

*Note: Collimated cable length including DM8000-ECABLE-X should not exceed 50 m.

DataMan Base Station Cables

- RS-232 cable for base station, 5 m
  DMA-RS232-05
- USB cable for base station: Use any standard USB-A to USB-B 2.0 cable up to 3 meters
- Ethernet cable for base station: Use any standard CAT5/5e, SF/FTP or S/FTP cable

Physical Layout of the Reader

1. Lanyard hook
2. Indicator light
3. Communication module insertion point

WARNING: LASER LIGHT, DO NOT STARE INTO BEAM

Laser aimer
UltraLight (DataMan 8500 only)
Trigger (press and hold to read)

Communication module insertion point
Physical Layout of the Base Station

Connection point with the reader:
• pairing reader and base station
• non-wireless communication
• charging

Base station status indicators:
• Power: RED = base powered / BLINK = wrong reader in base
• Communication: BLUE = WiFi link / BLINK = WiFi communication
• Cradle connections: GREEN = reader properly inserted / BLINK = cradle USB interface communication

Overview of Setting Up the Reader

To be able to connect to your reader or base station on your computer, you must perform the following steps:

1. Install the Setup Tool on your computer.

2. Select the connection type: Ethernet, Serial, or USB; and connect the appropriate cabling.

Alternatively, wireless connection modes can be used to connect to the reader directly (see page 34-35).

3. Power on your device(s).
Install DataMan 8000 Software

1. Check the DataMan Release Notes for a full list of system requirements.
3. Connect the DataMan 8100/8500 reader to your PC.
4. Launch Setup Tool and click Refresh. The reader or the base station appears under **COM ports** or **Network devices**.
5. Select a **COM port** or a **Network device** and click **Connect**.

Start the Setup Tool

Connect the reader to Setup Tool to configure it with the type of symbologies it will decode as well as other parameters, such as the type of trigger it will use and the format of the results it will generate.

Alternatively, configure your reader by scanning the appropriate reader configuration code from the **Reader Configuration Codes** document, available through the Windows Start menu or the Setup Tool Help menu.

**Quick Setup**
Configure your reader in a few basic steps.

**Connect to Reader**
Establish a connection to the reader.

**Results Display**
View the results.

**Light and Imager Settings/UltraLight Settings**
Choose a trigger type and other acquisition parameters.

**System Settings**
Configure visual and audio feedback, trigger and output actions.
Use the Setup Tool Menu Bar

Each reader can store its current set of runtime parameters to a configuration (.cfg) file that contains information, such as the enabled symbologies and how any output data should be formatted.

The same configuration file can be loaded onto multiple readers, as the file does not contain identification information such as the IP address or device name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which stores the set of runtime parameters plus any identification data, such as the name of the device, its IP address, subnet mask, and so on. Cognex recommends generating a device configuration file for each reader to allow you to restore a reader to its operating state with minimal effort.

Use the File menu of the Setup Tool to manage .cfg and .cdc files:

<table>
<thead>
<tr>
<th>File Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Configuration</td>
</tr>
<tr>
<td>Save Configuration</td>
</tr>
<tr>
<td>Print Configuration Code</td>
</tr>
<tr>
<td>Restore Device</td>
</tr>
<tr>
<td>Backup Device</td>
</tr>
<tr>
<td>Print Device Backup Code</td>
</tr>
<tr>
<td>Export Parameters</td>
</tr>
</tbody>
</table>

Use the Edit menu for standard Cut, Copy and Paste operations.

Use the View menu to view reader information (serial number, firmware version, and so on) and to enable and disable various elements of the Setup Tool, and the Tasks menu to switch between various Setup Tool options.

Use the System menu to manage the current settings on the reader and to upgrade the features it currently supports:

<table>
<thead>
<tr>
<th>System Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Settings</td>
</tr>
<tr>
<td>Reset Configuration</td>
</tr>
<tr>
<td>Update Firmware</td>
</tr>
<tr>
<td>Upload Feature Key</td>
</tr>
<tr>
<td>Show Device Log</td>
</tr>
<tr>
<td>Delete Device Log</td>
</tr>
</tbody>
</table>

Use the Help menu to display Setup Tool version information.

NOTE that Setup Tool does not allow you to update firmware if the battery is less than 30% charged. It is therefore recommended to place your device on the base station for charging before you update firmware.
Connecting a Handheld Through Ethernet

1. Connect the Ethernet slide-in (DMCM-ENETM-00) to your DataMan 8100/8500.
2. With a 2.5 mm Allen Wrench, tighten the screws so that the slide-in is firmly locked.
3. Insert the plug and slide the cable lock up to the reader and twist the cable lock in place.

Use the DM8000-ECABLE-05 (5 meters) or the DM8000-ECABLE-30 (30 meters). You also need a Power Over Ethernet Adapter (CPS-AC-POE1A-xx).

WARNING

Disconnect DataMan from power before inserting/removing communication modules.

Troubleshooting an Ethernet Connection

If your reader does not appear in the Setup Tool’s list of network devices, you may need to adjust your network settings.

First check your Ethernet connection and click Refresh in the Setup Tool. Next, scan the Enable DHCP code below (which you can also find in the DataMan Reader Configuration Codes document available from the Windows Start menu or the Setup Tool Help menu). This might allow the reader to acquire a suitable IP address from a DHCP server on your subnet.

If the reader still does not appear, you can use either the Add Device or Force Network Settings options in the Setup Tool.

If you know the IP address of the reader, use the Add Device option. If you do not know the IP address, use the Force Network Settings options. Either method should allow the DataMan 8100/8500 reader to appear in the list of Network devices so that you can connect to it through the Setup Tool and your Ethernet connection.

If none of the above helps, reset your reader to factory defaults by scanning the Reset Scanner to Factory Defaults code below.
**Connecting a Handheld Through RS-232**

1. Connect the serial slide-in (DMCM-SERIALM-00) to your DataMan 8100/8500.

2. With a 2.5 mm Allen Wrench, tighten the screws so that the slide-in is firmly locked.

3. Insert the plug and slide the cable lock up to the reader and twist the cable lock in place.

Use the DM8000-RS232-02 cable (2.5 meters) or the DM8000-RS232-05 cable (5 meters). For power supply, use the DataMan 8000 Power Supply (DM100-PWR-000).

**WARNING**
Disconnect DataMan from power before inserting/removing communication modules.

**Observe the following electrical requirements:**

1. **WARNING**
   For proper RS-232 operation, do not apply any voltage to pin 9.

2. 6VDC power supply (DM100-PWR-000), a 5.5mm x 2.1mm DC Power Plug
   2. VCC = +4.75V up to +6.0V for 2.5 m cable
      VCC = +5.5V up to +6.0V for 5.0 m cable

Power on the RS-232 cable can be supplied by either the DC Power Plug or Pin 1 of the D-SUB. **DO NOT** use both in parallel.
Keyboard Emulation With Keyboard

1. Connect the PS/2 keyboard adapter to your unpowered PC.
2. Connect your PS/2 keyboard to the PS/2 keyboard adapter, and start up your PC.
3. Connect your reader to an RS-232 cable and power up your reader.
4. Scan the PS/2 Keyboard Emulation Disable Configuration Code (from the Reader Configuration Codes document, available through the Windows Start menu or the Setup Tool Help menu).
5. Connect the RS-232 cable to the PS/2 keyboard adapter.
You can change your reader’s configuration by switching back to the serial interface and connecting to the Setup Tool.

Keyboard Emulation Without Keyboard

1. Scan the PS/2 Keyboard Emulation Enable Configuration Code (from the Reader Configuration Codes document, available through the Windows Start menu or the Setup Tool Help menu.)
2. Power down your PC and unplug your device from power.
3. Connect the PS/2 keyboard adapter to your PC.
4. Connect your reader’s serial cable to the PS/2 keyboard adapter and plug in your device to power. Wait until the device boots up.
5. Power up your PC and start reading codes.
You can change your device’s configuration by scanning the appropriate Configuration Codes.
### Keyboard Emulation With WiFi Reader Using Keyboard

1. Connect the PS/2 keyboard adapter to your unpowered PC.
2. Connect your PS/2 keyboard to the PS/2 keyboard adapter.
3. Start up your PC.
4. Power up your base station.
5. With your wireless reader, scan the Base Station PS/2 Keyboard Emulation Disable Configuration Code from the Reader Configuration Codes document, available through the Windows Start menu or the Setup Tool Help menu.
6. Connect the base station to an RS-232 cable, and plug it in to the PS/2 keyboard adapter.
7. Start reading codes.

You can change the configuration of your device by switching back to the serial interface and connecting to Setup Tool.

---

### Keyboard Emulation With WiFi Reader Without Keyboard

1. With your wireless reader, scan the Base Station PS/2 Keyboard Emulation Enable Configuration Code from the Reader Configuration Codes document, available through the Windows Start menu or the Setup Tool Help menu.
2. Disconnect your base station’s serial cable from your PC.
3. Power down your PC and unplug your device from power.
4. Connect your base station’s serial cable to the PS/2 keyboard adapter and plug in your device to power.
5. Connect the PS/2 keyboard adapter to your PC.
6. Power up your PC and start reading codes.

You can change the configuration of your device by scanning the appropriate Configuration Codes.
Connecting a DataMan 8100/8500 Through USB

1. Connect the serial slide-in (DMCM-SERIALM-00) to your DataMan 8100/8500.

2. With a 2.5 mm Allen Wrench, tighten the screws so that the slide-in is firmly locked.

3. Insert the plug and slide the cable lock up to the reader and twist the cable lock in place.

Use the DM8500-USB-00 cable (2.5 meters) or the DM8500-USBC-02 cable (2.5 meters). For DataMan 8500, use an external power supply: DataMan 8000 Power Supply (DM100-PWR-000).

NOTE: DataMan 8100 does not require an external power supply.

WARNING

Disconnect DataMan from power before inserting/removing communication modules.

Using Your Device Through USB

If you connect your reader with the coiled USB cable, you must use your device in USB 1.1 mode. With a straight USB cable, you can use your device in both modes.

Change the USB Connection in the Serial tab of the Communication Settings pane in Setup Tool, or scan the appropriate code from the DataMan Configuration Codes document.

<table>
<thead>
<tr>
<th>USB Connection</th>
<th>USB 1.1 mode</th>
<th>USB 2.0 mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Driver Compatibility Mode</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

You can also switch the USB mode (CDC or HID) of both the reader and the base station with a pair of RP codes. Perform the following steps:

1. Disconnect from Setup Tool if you are connected.

2. Scan the “USB Keyboard” code from the DataMan Configuration Codes document.

3. Start scanning codes with your corded reader.

1. Disconnect from Setup Tool if you are connected.

2. Scan the “Enable USB Keyboard for the base station” code from the DataMan Configuration Codes document.

3. Start scanning codes with your wireless reader.
Connecting to a Wireless DataMan 8100/8500 Through a Base Station

1. Connect the wireless slide-in (DMCM-WLESSM-00) to your DataMan 8100/8500.

2. With a 2.5 mm Allen Wrench, tighten the screws so that the slide-in is firmly locked.

3. Insert the battery.

4. Insert the plug and twist it in place.

5. Power up the base station using either a 24V power supply, or a Class 3 Power Over Ethernet adapter.

6. Connect your base station to your PC using either serial, USB or Ethernet communication.

WARNING
Remove battery from your DataMan before inserting/removing the communication module.
Wireless Connections (Continued)

Observe the following electrical requirements when connecting the base station through RS-232:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N/C</td>
</tr>
<tr>
<td>2</td>
<td>TxD</td>
</tr>
<tr>
<td>3</td>
<td>RxD</td>
</tr>
<tr>
<td>4</td>
<td>N/C</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>N/C</td>
</tr>
<tr>
<td>7</td>
<td>CTS</td>
</tr>
<tr>
<td>8</td>
<td>RTS</td>
</tr>
<tr>
<td>9</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

**WARNING**
For proper RS-232 operation, do not apply any voltage to pin 9.

Power to the base station can be supplied by either the DC Power Plug or a Power over Ethernet device. **DO NOT** use both in parallel.

The DC power plug is a 24VDC power supply (DMA-24VPWR-xx), 3.5mm x 1.3mm.

7. When the base station is powered up, place your reader into the base station. They become automatically paired. The base station’s status indicator becomes green. When the wireless reader is removed from the base, a wireless connection is established. The status indicator of both the base station and the reader become blue and you can hear a beep. Blue lights indicate that the reader and the base have successfully paired and are communicating.

8. Connect to your base station or to the wireless reader. You have the following connection options:

<table>
<thead>
<tr>
<th>Base Station Connection Type</th>
<th>Connect to Reader in the Setup Tool</th>
<th>Connection Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td>Wireless reader appears: COM port (Base Station does not appear)</td>
<td>terminal program Setup Tool</td>
</tr>
<tr>
<td>USB</td>
<td>Base Station appears: COM port 1 Wireless reader appears: COM port 2</td>
<td>terminal program Setup Tool</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Base station appears: Network device 1 Wireless reader appears: Network device 2</td>
<td>terminal program Setup Tool</td>
</tr>
</tbody>
</table>
9. Lift your reader up from the base station and start reading codes.

NOTES

• When the reader is on the base station, communication is established by means of cradle contacts. Wireless communication is disabled.

• Configure wireless communication settings by connecting to the base station. In order for the changed settings to be synchronized between the DataMan 8100/8500 wireless reader and the base station, place your reader in the base station after your changes are saved. To assign a static IP address to the base station or the reader when communicating via Ethernet, connect to the base station in Setup Tool. The base station, however, auto-assigns the IP address to the reader when they become paired.

• When you connect with the base station to a terminal program, your wireless reader sends decode results to the terminal, but you cannot send commands to the reader.

• If you want to unpair your reader from the base station, you can either click Unassign in the Wireless tab of the Communication Settings pane of Setup Tool (when you are connected either with the reader or the base station), or scan the “Unassign Reader” reader configuration code.

• If you place the wrong reader (that is, a reader that is not associated with the base station) into the base station, the base station status indicator flashes red and a long beep can be heard.

Wireless Connections (Continued)

Base Station Routing Capabilities

The base station is visible as connected through either RS-232, USB or Ethernet, but it routes data through the wireless interface to the reader.
Ad-hoc Mode

It is possible to connect to the reader wirelessly with the computer in ad-hoc mode (using a reader-created Wifi connection). Reset the reader to factory defaults (this configures the device to ad-hoc mode), and after the device appears under Wifi connections, connect to it with Setup Tool and then use the Wireless tab under Communication Settings to configure authentication and encryption (which are not configured by default). For more information, see the Communications and Programming Guide.

NOTE:
- The base station is only used for charging the reader in this setup. If an intelligent base station is used, the reader has to be unassigned in Setup Tool (connected to the base station) under Communication Settings > Wireless tab if the reader has already been placed in the base station.
- Also note that placing the reader in the intelligent base station automatically re-assigns it to the base station unless the base station is unplugged from the network first.

Infrastructure Mode

It is possible to connect to the reader in infrastructure mode using Wifi connection. You need to reset the reader to factory defaults, connect to the device in ad-hoc mode, and then use the Wireless tab under Communication Settings to activate and configure infrastructure mode.

Infrastructure mode requires a router as an access point. Encryption and authentication are available as seen in the table below. See the Communications and Programming Guide for detailed information.

<table>
<thead>
<tr>
<th>Authentication mode</th>
<th>Encryption</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open System</td>
<td>WEP-40, WEP-104</td>
<td>passphrase</td>
</tr>
<tr>
<td>WPA-PSK, WPA2-PSK</td>
<td>TKIP, AES, TKIP/AES</td>
<td>passphrase</td>
</tr>
</tbody>
</table>
| EAP-TLS             | TKIP, AES, TKIP/AES | • Client's certificate
|                     |                      | • CA's certificate
|                     |                      | • Client's private key
|                     |                      | • Client's username |
| PEAP-MSCHAPv2       | TKIP, AES, TKIP/AES | • CA's certificate
|                     |                      | • Client's username
|                     |                      | • Client's password |

NOTE:
- The base station is only used for charging the reader in this setup. If an intelligent base station is used, the reader has to be unassigned in Setup Tool (connected to the base station) under Communication Settings > Wireless tab if the reader has already been placed in the base station.
- Also note that placing the reader in the intelligent base station automatically re-assigns it to the base station unless it is unplugged from the network first.
Wireless Reader: Buffering Data

When you are within the wireless range of the base station, your wireless reader sends decoded data to your PC through the base station, just as if you used a tethered reader. You can also see the decoded images in Setup Tool, if it is running and is connected to the reader.

When you leave the wireless range, however, you lose connection to your PC, but you can still keep reading codes. The decoded data is saved in the buffer of the reader.

This buffered data appears on your PC again when you come back within the wireless range, but ONLY IF you were connected to a terminal program when you left the wireless range.

Buffered read results on the reader are not displayed in Setup Tool; they are only transmitted over an existing keyboard emulation, RS-232 Serial or TCP/IP Telnet connection. NOTE that the images acquired by the reader when it is out of the wireless range are never saved, and cannot be retrieved.

Open a connection with the reader in a terminal program so that you gain the buffered data when wireless connection is established again.

See the following table for connection options according to communication type:

<table>
<thead>
<tr>
<th>Base Station Connection Type</th>
<th>How to Connect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td>Connect to the COM port of the base station.</td>
</tr>
<tr>
<td>USB</td>
<td>Connect to the COM port of the wireless reader.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Connect to the terminal program using the IP address of the reader. To find out the IP address, go to the Connect to Reader pane in Setup Tool and hover your mouse over the reader. The IP address appears.</td>
</tr>
<tr>
<td>PS/2 Keyboard or USB Keyboard</td>
<td>Open the text editor or your program of choice to use keyboard emulation. When you return to the wireless range, keyboard emulation continues, starting with the buffered data.</td>
</tr>
</tbody>
</table>

While you are still within the wireless range, the reader occasionally blinks blue to indicate that the wireless connection is established.

When the reader leaves the wireless range, the base station’s signal becomes red.

Blinking blue status indicator: wireless connection is alive.
**Wireless Reader: Buffering Data (Continued)**

When you leave the wireless range, you can still keep reading codes. The reader going offline is indicated by a long beep and the status indicator flashes magenta.

- status indicator blinks magenta: your reader is offline

When the reader is offline, good reads are indicated with 2 short beeps and the selected good read status indicator color (green by default).

- status indicator beeps twice: your reader is offline while decoding symbols

When the buffer is full, no more codes are read. The reader does not discard the oldest read.

- when the buffer is full, the reader beeps and the status indicator becomes white

---

**Summary of Wireless Buffering Indicators**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status Indicator: Reader</th>
<th>Status Indicator: Base Station</th>
<th>Sounds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader in wireless range of base station</td>
<td>When the reader is awake, blinking blue indicates wireless connection with base. When the reader is offline, no indicator. Pull the trigger to wake it up and it will blink blue. Good read: green, single beep (default) No read: red, no beep (default)</td>
<td>Reader out of the base station and reader is awake: steady blue. Reader out of the base station and reader is offline: steady red. Paired reader in the base station: steady green. Base station is receiving data or images from reader: flashing blue.</td>
<td>Good read: 1 beep (default) No read: no beep (default)</td>
</tr>
<tr>
<td>Reader out of wireless range of base station</td>
<td>Offline: When the reader wakes up out of the wireless range, there is no indicator. Good read: green (default) No read: red (default)</td>
<td>Reader offline: steady red.</td>
<td>Long beep when you leave the wireless range. Good read: 2 beeps No read: no beep</td>
</tr>
<tr>
<td>Reader out of wireless range, buffer is full</td>
<td>Good read: green and then white. No read: red (default)</td>
<td>Reader offline: steady red</td>
<td>Good read: long beep No read: no beep</td>
</tr>
</tbody>
</table>
Wireless Reader: Charging

When you are reading codes with your wireless reader, blinking red status indicators will indicate a low battery. As the battery discharges, the blink frequency increases.

Blinking red status indicator indicates low battery or thermal shutdown mode.

Place the reader on the base station for charging. Make sure that the pins at the end of the handle make contact with the pins in the base station.

You can also check the status of the battery in Setup Tool.
Wireless Reader: Charging (Continued)

Refer to the following table for a summary of indicators regarding charging.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status Indicator: Reader</th>
<th>Status Indicator: Base Station</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery low</td>
<td>flashing red indicators</td>
<td>• steady blue, indicating wireless connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• flashing blue, indicating data transfer</td>
</tr>
<tr>
<td>Reader is charging in the base station</td>
<td>steady red indicators</td>
<td>• steady green, indicating wireless connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• flashing green, indicating data transfer</td>
</tr>
<tr>
<td>Reader is fully charged in the base station</td>
<td>steady green indicators</td>
<td>• steady green, indicating wireless connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• flashing green, indicating data transfer</td>
</tr>
</tbody>
</table>

To change batteries, perform the following steps:

1. Twist the reader’s end cap, and take it off.

2. Hold the reader in an upright position and the battery will slide out of the handle. NOTE that you may need to shake the reader slightly.

CAUTION

The battery used in these devices may present a risk of fire or chemical burn if mistreated. Do not disassemble, heat above 60°C (140°F), or incinerate. Replace battery with Cognex DMA-HHBATTERY-00 or DMA-HHBATTERY-01 only. The use of another battery may present a risk of fire or explosion.
Wireless Reader: Changing Batteries (Continued)

3. Put the replacement battery into the slot. The battery has a small triangle on one side. Make sure that you insert the battery in a way that the triangle end goes into the slot first.

4. Put the end cap back on and twist it.

5. Place the battery in the spare battery charger in the direction of the small triangle of the battery.

When you are charging the auxiliary battery, the base station’s spare battery status indicator displays either charging in progress (red) or fully charged (green).

6. Dispose of used battery promptly. Keep it away from children. Do not disassemble and do not burn it. Use the appropriate separate take-back systems for battery disposal.

Make sure that the triangle aligns with the circle when the cover is locked.
Trigger Types

The DataMan 8100/8500 trigger mode determines when the reader attempts to read a code. Use Setup Tool or the appropriate reader configuration codes to change trigger types.

The following trigger types are supported:

- **Presentation**: The laser aimer is always on. When motion is detected in front of the reader, the reader will turn on and scan for a symbol. The reader relies on an internal timing mechanism to acquire images.

- **Manual (default)**: Begins acquiring images when you press the trigger button on the reader, and continues acquiring images until a symbol is found and decoded or you release the button.

Field of View and Reading Distances

There is a range of reading distances available for different code sizes and focus positions. Select a focus position that allows you to read the desired code sizes at the desired working distance.

- If your application has a consistent reading range, set the focus range to a limited depth of field with no steps (for example, set it to 20) or with limited steps (for example, set it to 2 steps between 0 and 30). This way you can achieve fast performance.

- If your application has a variety of code types and sizes, set the focus range to a wider depth of field with increased number of steps (for example, set it to 6 steps between 0 and 200). This way you can get better coverage.

DataMan 8100/8500 Imager Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>DataMan 8100/8500 Imager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Sensor</td>
<td>1/2 inch CMOS</td>
</tr>
<tr>
<td>Image Sensor Properties</td>
<td>5.2 μm square pixels</td>
</tr>
<tr>
<td>Image Resolution (Pixels)</td>
<td>1280 x 1024</td>
</tr>
</tbody>
</table>
Map of Field of View and Reading Distances

- **1-D** objects:
  - 5 mil: 75 mm (2.9 in)
  - 10 mil: 210 mm (8.2 in)
  - 20 mil: 374 mm (14.7 in)

- **2-D** objects:
  - 5 mil: 154 mm (6.06 in)
  - 10 mil: 200 mm (7.87 in)
  - 20 mil: 312 mm (12.2 in)
  - 30 mil: 396 mm (15.5 in)
Industrial Protocols

The DataMan 8100/8500 readers support the following industrial protocols:

• EtherNet/IP™
• PROFINET
• MC Protocol
• Modbus TCP

Select the industrial protocol tools and sample programs when installing the Setup Tool.

There are three ways to enable or disable Industrial Protocols. Using either method, a reboot is required for the changes to come into effect.

• Enable the protocols using the Industrial Protocols pane of the Setup Tool (under Communication Settings).

• Scan the appropriate Reader Configuration codes (see Reader Configuration Codes available through the Windows Start menu or the Setup Tool Help menu).

• Send the appropriate DMCC (see Command Reference available through the Windows Start menu or the Setup Tool Help menu).

For more information on using the industrial protocols, read the DataMan Communications and Programming Guide available through the Windows Start menu or the Setup Tool Help menu.

DataMan 8100/8500 Specifications

| Weight | 326 g |
| Operating Temperature | 0°C — 40°C (32°F — 104°F) |
| Storage Temperature | -40°C — 60°C (-40°F — 140°F) |
| Maximum Humidity | 95% (non-condensing) |

| Codes | Data Matrix™; QR Code and microQR Code; UPC/EAN/JAN; Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 93, Pharma, Postal, RSS/CS, PDF 417, MicroPDF 417 |
| Power Supply Requirements | • DataMan 8100:
   • USB: USB BUS powered (optionally: external 2.5 W maximum LPS or NEC class 2 power supply: +5V - +6V DC)
   • RS232 external 2.5Wmax LPS or NEC class 2 power supply +5V - +6V DC
   • ETH: Class 2 PoE supply IEEE 802.3af*

• DataMan 8500:
   • USB: external 5.0 W maximum LPS or NEC class 2 power supply: +5V - +6V DC
   • RS232 external 5.0Wmax LPS or NEC class 2 power supply +5.50V - +6.0V DC (5.0m RS-232 cable)
   • +4.75V - +6.0V DC (2.5m RS-232 cable)
   • ETH: Class 2 PoE supply IEEE 802.3af*
   * connect only to PoE networks without routing to the outside plant

| Inrush current peak | 5A maximum
| Duration: approx. 30µs
| Electrical charge: 60µAs at 6V |

| Battery life for wireless reader (typical use case) | ca. 2900 triggers can be operated within a 10 hour working shift |
| WiFi | 802.11 b/g, 2.4 GHz, User Selectable channels 1-11 |
| Ethernet | 10/100 Base-T FULL/HALF DUPLEX, IEEE 802.3 |
DataMan Base Station Specifications

<table>
<thead>
<tr>
<th>DMA-IBASE-00</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td><strong>Operating Temperature</strong></td>
</tr>
<tr>
<td><strong>Storage Temperature</strong></td>
</tr>
<tr>
<td><strong>Maximum Humidity</strong></td>
</tr>
<tr>
<td><strong>Power Supply Requirements</strong></td>
</tr>
</tbody>
</table>

Laser Information

**LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT**

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS INJURY

- **CAUTION**: Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.
- Do not attempt to service or repair this product -- return it to Cognex for service.
- Do not permit anyone other than Cognex Corporation to service, repair, or adjust this product.
- Do not attempt to open or modify this device except as described in this document.
- Do not direct or reflect laser light toward people or reflective objects.
- Do not operate this device if it is damaged or if the covers or seals are missing or damaged.

This Laser Product is designated as Class 2 during all procedures of operation.

| **Wavelength** | 650 nm |
| **Laser Power for classification** | < 1 mW |
| **Beam Diameter** | < 3mm at aperture |
| **Divergence** | < 5 mrad |

For assistance contact Cognex Corporation at http://support.cognex.com
The DataMan 8000 series device meets or exceeds the requirements of all applicable standards organizations for safe operation. However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency guidelines that follow. Please read these guidelines carefully before using your device.

The following specifications apply to the DataMan 8100/8500 corded readers:

<table>
<thead>
<tr>
<th>Regulator</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>FCC Part 15B, Class A</td>
</tr>
<tr>
<td></td>
<td>FCC Part 15.247</td>
</tr>
<tr>
<td></td>
<td>FDA/CDRH Laser Notice No 50</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003</td>
</tr>
<tr>
<td>European Community</td>
<td>EN55022, Class A</td>
</tr>
<tr>
<td></td>
<td>EN60950</td>
</tr>
<tr>
<td></td>
<td>EN60825-1</td>
</tr>
<tr>
<td>Australia</td>
<td>C-TICK, AS/NZS CISPR 22 / EN 55022 for Class A Equipment</td>
</tr>
<tr>
<td>Japan</td>
<td>J55022, Class A</td>
</tr>
</tbody>
</table>

The following specifications apply to the DataMan 8000 wireless readers:

<table>
<thead>
<tr>
<th>Regulator</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>FCC Part 15B, Class A</td>
</tr>
<tr>
<td></td>
<td>FCC Part 15.247</td>
</tr>
<tr>
<td></td>
<td>FDA/CDRH Laser Notice No 50</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003</td>
</tr>
<tr>
<td></td>
<td>RSS 210</td>
</tr>
</tbody>
</table>

### Agency Compliance Statements

**FCC Class A Compliance Statement**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules and with RSS-210 of Industry Canada. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications made to this equipment not expressly approved by Cognex may void the FCC authorization to operate this equipment.

**Radiofrequency radiation exposure information:**

For body worn operation, this device has been tested and meets the FCC RF exposure guidelines when worn in hand or close to the body. Use of any accessory may not ensure compliance with FCC RF exposure guidelines.
Agency Compliance Statements (Continued)

Canadian Compliance
This Class A digital apparatus complies with Canadian ICES-003. Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Japanese Compliance
These devices have been granted a designation number by the Ministry of Internal Affairs and Communications according to the Ordinance concerning the Technical Regulations Conformity Certification etc. of Specified Radio Equipment (特定無線設備の技術基準適合証明等に関する規定). Article 2 clause 1 item 19 Approval n°: 202WW11139331 These devices should not be modified (otherwise the granted designation number will become invalid).

C-Tick Statement
Conforms to AS/NZS CISPR 22/ EN 55022 for Class A Equipment.

Cofetel Notice
La operacion de este equipo esta sujeta a las siguientes dos condiciones: (1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operacion no deseada. COFETEL ID: RCPCODM12-0654

European Compliance
This equipment complies with the essential requirements of EU Directives 1999/5/EC, 2004/108/EC and 2006/95/EC, as applicable. Declarations are available from your local representative. 

These devices have been granted a designation number by the Ministry of Internal Affairs and Communications according to the Ordinance concerning the Technical Regulations Conformity Certification etc. of Specified Radio Equipment (特定無線設備の技術基準適合証明等に関する規定). Article 2 clause 1 item 19 Approval n°: 202WW11139331 These devices should not be modified (otherwise the granted designation number will become invalid).

C-Tick Statement
Conforms to AS/NZS CISPR 22/ EN 55022 for Class A Equipment.

Cofetel Notice
La operacion de este equipo esta sujeta a las siguientes dos condiciones: (1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operacion no deseada. COFETEL ID: RCPCODM12-0654

European Compliance
This equipment complies with the essential requirements of EU Directives 1999/5/EC, 2004/108/EC and 2006/95/EC, as applicable. Declarations are available from your local representative.
Agency Compliance Statements (Continued)

dostępne u lokalnych przedstawicieli.


Agency Compliance Statements (Continued)

Laser Safety Statement

Complies with FDA performance standards for laser products except for deviations pursuant to Laser Notice No. 50, dated June 24, 2007. This device has been tested in accordance with IEC60825-1 2nd ed., and has been certified to be under the limits of a Class 2 Laser device.

UL and cUL Statement

UL and cUL listed: UL60950-1 1st ed. and CSA C22.2 No.60950-1 1st ed.

UL and cUL Statement

UL and cUL listed: UL60950-1 1st ed. and CSA C22.2 No.60950-1 1st ed.
Agency Compliance Statements (Continued)

For European Union Users

This product has required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of the materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed of along with municipal waste and invites you to use the appropriate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You may also contact your supplier for more information on the environmental performance of this product.

Brazilian Compliance
Este produto está homologado pela ANATEL, de acordo com os procedimentos regulamentados pela Resolução 242/2000, e atende aos requisitos técnicos aplicados.

Para maiores informações, consulte o site de ANATEL www.anatel.gov.br

Este equipamento opera em caráter secundário, isto é, não tem direito a proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário.
Agency Compliance Statements: DataMan Base Station

The DataMan Base Station meets or exceeds the requirements of all applicable standards organizations for safe operation. However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency guidelines that follow. Please read these guidelines carefully before using your device.

<table>
<thead>
<tr>
<th>Regulator</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>FCC Part 15B, Class A</td>
</tr>
<tr>
<td></td>
<td>FCC Part 15.247</td>
</tr>
<tr>
<td></td>
<td>FDA/CDRH Laser Notice No 50</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003</td>
</tr>
<tr>
<td></td>
<td>RSS 210</td>
</tr>
<tr>
<td>European Community</td>
<td>EN301 489-1 / -17</td>
</tr>
<tr>
<td></td>
<td>EN300 328-2</td>
</tr>
<tr>
<td></td>
<td>EN60950</td>
</tr>
<tr>
<td>Australia</td>
<td>C-TICK, AS/NZS CISPR 22 / EN 55022 for Class A Equipment</td>
</tr>
<tr>
<td>Japan</td>
<td>J55022, Class A</td>
</tr>
<tr>
<td></td>
<td>ARIB STD-T66</td>
</tr>
</tbody>
</table>

**FCC Class A Compliance Statement for the DataMan Base Station**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules and with RSS-210 of Industry Canada. Operation is subject to the following two conditions:

1. this device may not cause harmful interference, and
2. this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications made to this equipment not expressly approved by Cognex may void the FCC authorization to operate this equipment.

**Canadian Compliance**

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

**Japanese Compliance**

These devices have been granted a designation number by the Ministry of Internal Affairs and Communications according to the Ordinance concerning the Technical Regulations Conformity Certification etc. of Specified Radio Equipment (特定無線設備の技術基準適合証明等に関する規則).

Article 2 clause 1 item 19

Approval n°: 202WW11139332

These devices should not be modified (otherwise the granted designation number will become invalid).

**C-Tick Statement**

Conforms to AS/NZS CISPR 22/ EN 55022 for Class A Equipment.

**Cofetel Notice**

La operacion de este equipo esta sujeta a las siguientes dos condiciones:
Agency Compliance Statements: DataMan Base Station (Continued)

(1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operacion no desead.

COFETEL ID: RCPCODM12-0655

UL and cUL Statement

UL and cUL listed: UL60950-1 2nd ed. and CSA C22.2 No.60950-1 2nd ed.

European Compliance

This equipment complies with the essential requirements of EU Directives 1999/5/EC, 2004/108/EC and 2006/95/EC, as applicable. Declarations are available from your local representative.


Agency Compliance Statements: DataMan Base Station (Continued)

For European Union Users

This product has required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of the materials of the product you are disposing in a sound way.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You may also contact your supplier for more information on the environmental performance of this product.

Brazilian Compliance
Este produto está homologado pela ANATEL, de acordo com os procedimentos regulamentados pela Resolução 242/2000, e atende aos requisitos técnicos aplicados.

Para maiores informações, consulte o site de ANATEL www.anatel.gov.br

Este producto possui módulo integrado ao mesmo que opera em caráter secundário, isto é, não tem direito a proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário.
Reader Control Codes

- Reset Scanner to Factory Defaults
- Reboot Scanner
- USB Serial
- USB Keyboard
- Enable DHCP
- USB Keyboard for Base Station

Keyboard Language (Corded Readers Only)

- US English
- German
- French
- Spanish
- Japanese

Copyright © 2014 Cognex Corporation All Rights Reserved. This document may not be copied in whole or in part, nor transferred to any other media or language, without the written permission of Cognex Corporation. The hardware and portions of the software described in this document may be covered by one or more of the U.S. patents listed on the Cognex web site http://www.cognex.com/patents.asp. Other U.S. and foreign patents are pending. Cognex, the Cognex logo, UltraLight and DataMan are trademarks, or registered trademarks, of Cognex Corporation.